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 الملخص 

ا ل ههو التكامههل مههو طليههاهات العلههم وت  ي اتههه  ممهها يسهه م  ا متحا ههدد يشهه د الفههن المعاوههر توج ههد
ت ههو ر اداههداف الفنهه  وتعلههيم الفنههوا. يرعههد وهه ا الههربي ت ههو د جهه ر دا فهه  تههار خ الفههن ال ههد    فهه  

                     خاوهههههههة منههههههه  أواخهههههههر ال هههههههرا العشهههههههر ن  ومهههههههن المتوقهههههههو أا ي هههههههب  سهههههههمة  هههههههاره  فههههههه  ال هههههههرا 
 ال ادي والعشر ن.

  ره ميال طباعة المنسوجات كواحد من أوم ميا ت التشكيل الفن   حي   تههي  للفنههالين 
ا اتكههههار مههههن خههههلل التير هههه  المن يهههه   ت و ههههو الاامههههات  و عههههاد  وههههيا ة ا فكههههار  اسههههتادام 
ا فهه  ت ههديم حلههول تشههكيلية م تكههر   ممهها  الت نيههات ال د .ههة. كمهها لعهه  الب هه  والتير هه  دوردا م ور ههد
دفو الفنالين طلى است.مار التكنولوجيا  م.ل ارامج اليرافيك وال كاء ا و ناع   كههودوات لت ههو ر 

 .اداداف الفن  واست داث ويا ات جد د  ت.ري اللوحة ال باعية من حي  الشكل والمضموا 

                      اههههههههههرامج اليرافيههههههههههك  الهههههههههه كاء ا وهههههههههه ناع وههههههههههيا ات طباعيههههههههههة   :ات المفتاحي         ةالكلم         
 .مدارس المتفوقين
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ABSTRACT: 

Ontemporary art is witnessing a growing trend toward integration with 

scientific achievements and applications, contributing to the development of 

artistic creativity and art education. This connection represents a major 

transformation in modern art history, particularly since the late 20th century, 

and is expected to become a defining feature of art in the 21st century. 

The field of textile printing stands out as one of the most significant areas of 

artistic formation, allowing artists to innovate through systematic 

experimentation, material adaptation, and the reimagining of ideas using 

modern technologies. Research and experimentation have played a crucial role 

in presenting innovative artistic solutions, driving artists to harness 

technology—such as graphic design programs and artificial intelligence—as 

tools for enhancing artistic creativity and developing new formulations that 

enrich printed artworks in both form and concept. 

Keywords: printing formats, graphic programs, artificial intelligence, gifted 

schools 
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 :البحث  ةمقدم 
العلههم والفههن ومهها فرعههاا أساسههياا مههن النشههان الهه ون  لولسههاا   تشههاا اا و اتلفههاا فهه   ا  
واحد. منهه  الع ههور ال ديمههة  كههاا الفههن وسههيلة عمي ههة للتع يههر عههن ال يهها  ادلسههالية  حيهه  ع ههرت 
كههل حضههار  عههن أفكاروهها  وسههلوب ا الفنهه  الاههام  وقامههع ات يههيم تلههك التع يههرات اداداعيههة اههوع . 
أما العلم  في دف طلى تفسير العمليات ال  يعية وف دا لل والين ا ساسههية  حيهه  تاضههو كههل ل ر ههة 

 ل واعد م دد   تم اختباروا اوسائل متنوعة للووول طلى استنتاجات علمية دقي ة.
  شك أا التعاوا اين العلم والفن وال اقة البشر ة يم.ل أحههد م ههادر التنميههة  ممهها يسههاعد 

مواكبة الت دم السر و ومواج ههة الت ههديات التهه  تواجههه الميتمعههات  خاوههة مههو ت ههور الع ههول   على
 الم تكر  الت  تسعى الدول المت دمة  ست.مار طاقات ا.

: العلههوم  التكنولوجيهها  ال ندسههة  الر اعههيات تعههد STEMمن يية تعليم المتفوقين وفق ل ام 
تكامليههة التعلههيم اههين وهه ت الميهها ت   علههىمههن ا تياوههات التعليميههة العالميههة الرائههد . ف هه  تعتمههد 

ممههها  تهههي  لل هههلف ت هههو ر أفكهههاروم مهههن خهههلل ت و هههل ال هههوالين والمبهههاد  العلميهههة طلهههى ت  ي هههات 
عملية. كما يمكن ل  ا الن ج أا يعحه اداداف ف  الفنههوا مههن خههلل دراسههة عمليههة اداههداف العلمهه  

 ورب  ا  الفن.
 عت ههههر فههههن اليرافيههههك أحههههد أاههههره الوسههههائل التهههه  سههههاومع فهههه  ت ههههو ر الممارسههههات الفنيههههة و 

الت ليدية  حي  أتاح للفنالين طمكالية التع ير عن أفكاروم  وسالي  م تكر  و يههر ت ليديههة.  اسههتادام 
ا دوات الرقميههة المت ههور   يمكههن لفههن اليرافيههك اليمههو اههين العناوههر الواقعيههة والتير ديههة   ههر  

 جد د   مما  واك  مت لبات الع ر ال د  .
من ج ة أخرى  يم.ل الهه كاء ا وهه ناع  أحههد ت  ي ههات التكنولوجيهها ال د .ههة التهه  أحههد ع 

ت ههميم أل مههة م رميههة  علههىطفر  ف  ماتلف الميا ت   مهها فهه  ذلههك التعلههيم والفههن. ف ههو يعتمههد 
تمكن ال واسي  من التفكير و جراء عمليات تشبه الهه كاء البشههري. وقههد أسهه م الهه كاء ا وهه ناع  

              التعههههاوا اههههين  علههههىفهههه  ط ههههراء ميهههها ت اداههههداف الفنهههه  مههههن خههههلل ت ههههديم حلههههول م تكههههر  تعتمههههد 
 ادلساا والآلة.

وههو ال ر ههق ل ههو  شههكل عههام وفهه  طباعههة المنسههوجات  شههكل خههام التير هه  فهه  الفههن ف
 اههرامج اليرافيههك أسههتادام  و عت ههر  ري ت  يق اداداف المتاحة دجراء النشان التير    من ج ههة أخهه 

ا اهههداف  التعهههاوا مهههو ا لسهههاا والروبهههرت فههه  العلهههوم والفهههن  علهههىلهههه تهههو ير  ا وههه ناع الههه كاء و 
وخلههق ايتههات متعههدد  والتكنولوجيهها والتنههوف والشههمول فهه  العلههوم والتكنولوجيهها وال ندسههة والر اعههيات 

 التا  ات  ف و ميرد م اكا  للواقو.  
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وفههه  وههه ا النهههوف مهههن ال باعهههة عت هههر ال باعهههة الرقميهههة مهههن طهههر  ال باعهههة ال يهههر ت ليديهههة تو  

تسهههت دل ادوات ال باعهههة الماتلفهههة  الفهههور  وشاشهههة ال اسههه  الآلههه  كههه لك تسهههتادم ا لهههواا الرقميهههة 
وا حبار عوعا عن الملولات والعيائن ال باعيههة الت ليديههة دييههاد وههيا ات   ل ائيههة تت ههد في هها 
الرؤ ة الفنيههة والايههال  ال ههدرات الت نيههة العاليههة لل اسهه  الآلهه  لي   هها معهها ااههداعات فنيههة فهه  العمههل 
التشههكيل   وتههو يرات متنوعههة   ل ائيههة للووههول طلههى مرحلههة ال ههل  فنهه    حههدود لههه سههوي خيههال 

  ة .ارامج ما الفناا و ستادم لتنفي  ذلك  
أومية الب هه  عههن مههدخل جد ههد يسههم  للفنههاا ودارس الفههن  التعامههل مههو   علىالباح.ة  وتري  

وهه ا الههن ج   تكامههل الا ههرات اههين العلههم والفههن علههىأشههكال الفههن الماتلفههة مههن خههلل م ههدأ يعتمههد 
لفههن التير ههدي ووهه  أحههدي مههدارس الفههن ال ههد   كوسههلوف مههن ة ا يسههتند طلههى أسههة علميههة تههدر 

أسههالي  مهها  عههد ال ههرف العالميههة ا ولهه  وفهه  ططههار حركههه الت ههرر أوههب  الفنههاا فهه  حاجههة طلهه  
الاههروم مههن ال واعههد الت ليديههة ال ديمههه للووههول طلهه  طههر  جد ههدت وبنيههة  طاداعيههة تسههم  لههه ات ههديم 

وهه ا الهههن ج يعهههحه أعمههال   ر  هههة تيسههر لهههه عرعههه ا  لمههان مسهههت د ة   ههيا ت ا   هههر  م تكهههر   
 ير.العملية التربو ة و نم  الم ارات العملية لل لف  مما يمن  م حر ة ف  الفكر والتع 

 مشكله البحث :
والفن  ولتيية ا رتبان الو يق اين   تكنولوجيامما   شك فيه أا الفن أمر عروري لتعح ح ال 

فتر   كاا الواهف الرئيس  للباح.ة  طل  و ت التيربة الب .ية فمن خلل    والتكتولوجيا   العلم والفن
الباح. والتكنولوجياف     هعمل  للعلوم  المتفوقين  ا ا  م 2018  عام  مدارس  مو  حت   طلف    
 ح ع الباح.ه تدل  مستوي الم ارات الفنيه لدي      للمرحلة ال.الو ةالفن ميال  الف     المتفوقين  

ال در     STEMال لف المتفوقين ستيم   العلوم والر اعيات    التكنولوجيا توظيف    علىوعدم  اين 
يه ف  م ارات فن  عروري طكساا موال ندسه والتكنولوجيا  الميال الفن  ل لك تسع  الباح.ه طل   

المنسوجات   طباعة  الفن   ميال  للتع ير  المناسبة  الفروة  ارامج  التكنولوج و تاحة     وستادام 
 تتلاص مشكله الب   ف  التساؤل التال :   ومن و ا المن لق ا و ناع اليرافيك وال كاء 

   مبتكرة تناسباعية ب صياغات ط  في الاصطناعيبرامج الجرافيك والذكاء  توظيف  كيف يمكن 
 ؟  (STEMمدارس المتفوقين) مستويات طلاب  

 أهداف البحث:
 يهدف البحث الحالي إلي: 

                              اتكار معل ات م  وعة.  ا و ناع امكاليات ارامج اليرافيك وال كاء ا ستفاد  من   -1
  باع . وجمال   .ري العمل ال  ير ديت  يق أعمال فنية  ير ت ليدية ذات اتيات ت -2
 مو مست د ات   ا و ناع اكتساف ال در  ا اداعية ف  التعامل ت نيا وتع ير ا  ال كاء   -3

 . STEMمن خلل أتساف الرؤ ة الفنية والتشكيلية لدي طلف المتفوقين  الع ر     
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 أهميه البحث:  
   STEMتدعيم اليال  ا دراك  والتشكيل  مما  تي  الفروة لدي ال لف المتفوقين  -1
 لتنمية رؤي تع ير ة ترتبي  الايال وا اتكار.        
 ا س ام ف  فت  ميال التير   لدي ال لف المتفوقين كاحد المداخل ال امه  يياد   -2

 ا ستفاد  من ارامج اليرافيك وال كاء ا و ناع .  علىحلول تشكيليه قائمه        
 ربي العلوم  الفنوا   راء فكر ال لف المتفوقين ف  تنفي  معل ات طباعية رقمية.   -3

 فروض البحث: 
 يفترض البحث الحالي إلي:

      كمن لههههق تير  هههه   ا وهههه ناع يمكهههن ا سههههتفادت مههههن امكاليهههات اههههرامج اليرافيههههك والههه كاء  -1
 ل ناء معل ات طباعية تير دية مست د ة .

                      تنميهههههههههههههة اليالههههههههههههه  ا اتكهههههههههههههاري والم هههههههههههههاري لهههههههههههههدي ال هههههههههههههلف اسهههههههههههههتادام التكنولوجيههههههههههههها ل -2
 .STEM  المتفوقين

                أعمهههههها د  لتنفيهههههه وال باعههههههة الرقميههههههة  ا وهههههه ناع الههههههدمج اههههههين اههههههرامج اليرافيههههههك والهههههه كاء  -3
 أوالة.  أك.ر

 حدود البحث:
ال ال    الب    الت  ي   من خلل وعو   علىي ت ر  الفن   التير  يه والتع ير  الممارسات 

ال  ت نية  تير دية  وستادام  ارلامج   ومعالية  ا و ناع اء  كت ميمات  النواتج  وستادام 
  Adobe Photoshop cs5جرافيكال

 أسالي  ال باعة الرقمية.  -
 . أسلوف الفن التير دي  -
   مدرسة المتفوقين للعلوم والتكنولوجيا  كفر الشيخ( 16)عينة عشوائية من طلف  -
 البحث:  يةمنهج 
 -الت ليل  فى دراسة ما  لى: تبو الب   ال ال  المن ج الووف   

 ةواليماليهه ةالقههيم التشههكيلي علههىوالتير  هه  ا ههدف الووههول الهه  حلههول تشههكيليه مسههت د ه تعتمههد  -
اههرامج  علههى ههتم طسههتادام المههن ج الووههف  لدراسههة وت ليههل أعمههال ال ههلف الهه ي قههاموا اتنفهه وا 

 وطباعت ا  ال باعة الرقمية. اليرافيك 
  يستادم المن ج ا ست رائى ف  ت ليل النتائج والتوويات. -
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 سةالأطار النظري للدرا 
 ( STEMمدارس المتفوقين) -1

"يعهههد طدخهههال مهههدارس المتفهههوقين فهههى العلهههوم والتكنولوجيههها مهههن أاهههره المسهههتيدات فهههى السياسهههة 
التعليميهههة فهههى م هههر وأحهههد ال هههدائل الم روحهههة لت  يهههق الن لهههة النوعيهههة الم لوبهههة فهههى ل هههام التعلهههيم 
الم ههري"   ف امههع وهارت التربيههة والتعلههيم  الشههاء وحههد  مركح ههة اههد واا عههام الههوهار  لههدعم مههدارس 

 م(2018  -".)عحت المتفوقين فى العلوم والتكنولوجيا
اهههد ل  داخلههه  لوي حكوميهههةاوههه  مهههدارس  ههه  STEMمدرسهههة المتفهههوقين للعلهههوم والتكنولوجيههها 

رعايههة المتفههوقين فههى العلههوم الر اعههيات وال ندسههة ل م 2011تههم توسيسهه ا منهه  عههام   ال.الو ههة العامههة
   وحههدث ا ج ههح  العمليههة والمعامههل المت ههور  والف ههول المي ههح   وتمههام   ههدرات م والتكنولوجيهها وا 

اء  فيح هههاء  أحيهههاء  طلكتروليهههات  ل هههات  ويهههدروليك  يههه والتههه  تضهههم ف هههول دراسهههية  ومعامهههل كيم
 والم اكر .  جيولوجيا  روبوتيك  كم يوتر  ومعمل ااتكارات  وقاعات ال عام 

أكتههوبر  وتلت هها مدرسههة المتفوقههات احوههراء  6م فى مد نههة 2011ادأت الشاء و ت مدرسة عام 
فرعهها مههو  16م  وبعههدوا تههم التوسههو حتهه  الههو عههدد الفههروف 2012المعههادي  م اف ههة ال ههاور  عههام 

 -ال ههههاور   -طتبههههاف مواوههههفات موحههههد  ليميههههو المههههدارس فههههى م اف ههههات: الييههههح   علههههىال ههههرم 
 -ا ق هههر -أسهههيون  -الب هههر ا حمهههر  -ادسهههماعيلية  -الدق ليهههة  -كفهههر الشهههيخ  -ادسهههكندر ة 
 -السههادات  –الفيههوم  -سههووام  -المنيهها  -انهه  سههو ف  -قنهها  -الشههرقية  -ال ليوبيههة  -ال ربيههة 

 ال اور  اليد د .
 :تعريف مدارس المتفوقين •

   Science  Technology  Engineeringوو اخت ار لعد  كلمههات وهه   STEMم  ل  
and Mathematics  و عت ههر تعلههيم   والتهه   تعنههى : العلههوم والتكنولوجيهها وال ندسههة والر اعههيات

ل ههج مههن  علههىفلسههفة قائمههة  علههىالعلههوم والتكنولوجيهها وال ندسههة والر اعههيات تعليمهها تكامليهها يعتمههد 
الههتعلم  ههدمج   ههور  م  ههود  المفههاايم  والممارسههات التعليميههة فهه  ميههال  العلههوم والر اعههيات مههو 
مفههههاايم وممارسههههات التكنولوجيهههها والتعلههههيم ال ندسهههه   و اهلههههة ال ههههواجح الت ليديههههة اههههين التا  ههههات 

   .ا ربعة ودمي ا ف  تعليم واحد متماسك  ما  ؤدي طلى تكو ن و لشاء معرفة جد د  
المشهههروعات ا ست  هههائية  و"تعهههد فلسهههفة  علهههىو"ت  يهههق منهههاوج وطهههر  تهههدر ة جد هههد  تعتمهههد 
  ر  ههة تكامليههة مههن التوج ههات ال د .ههة  STEMتعلههيم العلههوم والتكنولوجيهها وال ندسههة والر اعههيات 

تههدر ة الموعههوعات فههى سههياقات تكامليههة اههين فههروف  علههىفههى التعلههيم  حيهه  ترتكههح وهه ت الفلسههفة 
المعرفههة العلميههة والتكنولوجيههة وال ندسههية  والر اعههيات سههعياد للت ههدي لضههعف مارجههات التههدر ة 
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المنفرد  للميا ت ا ربعة  ومن  م ا رت اء  م ارات ال الهه  لتتوافههق مههو مت لبههات ال ههرا ال ههادي 
 م(2019-)ولح الد ن م مدوالعشر ن ل ناء قوي عاملة م تكر  وتنافسية".  

توظيف المعلومات والمعارف    لل تم في ا التدر ة   ر  ة المشروعات من خ"ف   مدارس  
والم ارات الت  يكتس  ا ال ال  ف  ت ميم مشروعات تادم ال يتة الم لية الموجود ا ا المدرسة 

توه و ال ال  ف  ميموعات عمل لتنمية م ارات    لل وذلك من خ    أو الت   نتم  ل ا ال ال 
الم قو   طلى  رس  ما  ؤدي  ووو  التعاول    اليماع   ا يتته  حتى  لالعمل  ال ال   وربي  ح ة 

 . " ت ال يتة وال فاظ علي ا جحء من ممارسات ال ال  وشا يتهل  ل مشك   وتمام ي ب  ا
 للعلوم والتكنولوجيا  stemخصائص الطلبه المتفوقين في مدارس 

)العلوم والتكنولوجيا   STEM اتلف خ ائص طلف مدارس المتفوقين للعلوم والتكنولوجياي
وال ندسة والر اعيات( وف اد لل روف ا جتماعية وال. افية وا قت ادية للميتمو ال ي تنتم  طليه  

 :وتشمل  STEM  ناك  عض الا ائص المشتركة الت  تميح طلف مدارس  فو ت المدارس
ي  روا اوتماماد ك يراد  ميا ت العلوم والتكنولوجيا وال ندسة والر اعيات  مو رغبة مستمر     -

 ف  التعلم والت و ر. 
العلم  والب   عن    على تمتعوا   در     - المن ج  المشكلت  استادام  التفكير اداداع  وحل 

 المعرفة اليد د . 
 لد  م م ارات عالية ف  التعاوا  توه و الم ام  والتفاعل مو الفر ق لتنفي  المشار و والتيارف. -
  تميحوا  م ارات ت ليلية عمي ة لف م المفاايم العلمية والت نية وت و ر الن ر ات. -
 يمتلكوا ش فاد  التفو  والرغبة ف  ت  يق أوداف م  يدية و ورار. -
 ي  روا اوتماماد  التكنولوجيا ال د .ة واستادام ا ف  حل المشكلت وت و ر أفكار م تكر . -
 يسعوا دحداث تو ير طيياا  ف  الميتمو والعالم  استادام المعرفة والتكنولوجيا. -
 .التكيف مو الت يرات السر عة ف  العالم وميا ت التكنولوجيا  على تمتعوا  مرولة وقدر    -
 برامج الجرافيك -2

أج هههح  الكم يهههوتر وبهههرامج اليرافيهههك المت دمهههة   وهههىالت هههورات التكنولوجيهههة ال د .هههة   مهههن أوهههم 
ا ك يههههردا  فضههههل قههههدرت ا ف ا لههههدمام مههههو ماتلههههف الفنههههوا  علههههىو ههههارت فهههه  الآولههههة ا خيههههر  اوتمامههههد

الميههها ت العلميهههة والن ر هههة ف هههي  اهههل أوهههب ع  علهههىالتشهههكيلية. لهههم تعهههد ت ت هههر وههه ت الت نيهههات 
ا ف  كل ما وو حد   ومت ور.  عن ردا أساسيدا ومشتركد

ل ههههد أوههههب  الكم يههههوتر أدا  رئيسههههية فهههه  العد ههههد مههههن ا لشهههه ة ادلسههههالية  حيهههه  تههههم توظيههههف و 
ال.  فههه  ميهههال الفنهههوا التشهههكيلية  توسهههعع ت  ي اتهههه  شهههكل عهههام  و طمكالياتهههه المتنوعهههة  شهههكل فعههه 
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وت ل لههع اراميههه اليرافيكيههة ال د .ههة  شههكل خههام فهه  ميههال طباعههة المنسههوجات  ممهها أعههاف 
قيمة فر د . ف د أس مع و ت ال رامج ف  ت و ر معاليههة ال ههور والعناوههر الب ههر ة  مههو طمكاليههة 

 تعد ل تفاويل ا و عافة مؤ رات م تكر   مما أتاح للفناا فروة لتيد د أسلوبه الفن .
ميال ووب ف   ال د .ة  الت نيات  دمج  الممكن  من  أوب   المت ور    اليرافيك  أدوات  ستادام 

ال باعة  سواء من خلل ال باعة الرقمية الآلية أو دمج ال ور المرعالية مو ال باعة اليدو ة   
الميال و ا  ف   والتيد د  لواداف  جد د   يفت   فاقدا  و مما  اليرافيك     ارامج  ا  تعد  دوات  من 

وت ر ر  ا  طلشاء  من  الم ممين  تمكن  حي   الب ري   واداداف  الت ميم  ميا ت  ف   ساسية 
 فيما  ل   عض أاره و ت ال رامج:     والرسومات وال ور  فعالية 
( إليستريتور  الرسومات    ووو  (Adobe Illustratorأدوبي  ت ميم  ف   متا ص  ارلامج 

تك يروا دوا    ووو  (Vector Graphics)   المتي ية يمكن  الدقة  يستادم دلشاء رسومات عالية 
اليود  )    ف داا  طلشاء وو     (Canvaكانفا  للمستادمين  ترتي   ادلترلع  ع ر  ت ميم  من ة 

جاوح  قوال   )   ت اميم   ر ة  س ولة  استادام  درو  ارلامج   ووو  (CorelDRAWكوريل 
والن  ية المتي ية  الرسومات  وت ر ر  طلشاء  ف   يرستادم  متكامل  فوتوشوب     ت ميم  أدوبي 

(Adobe Photoshop)  
  Adobe Photoshopأدوبي فوتوشوب   
الت كم  " خالل  من  م ترف  ال ور  شكل  وتعد ل  لت ر ر  الفوتوشوف  ارلامج  يستادم 

 المعاليات الرقمية ل  ت ال ور وت  يق التو يرات علي ا ف و  وفر للم مم العد د من األدوات  
الت كم ف  طعاد  تشكيل ويا ت ا   كما  تمتو اوجود مكتبة لولية    علىواطلعدادات الت  تساعدت  

لواا  ف و يعت ر أحد ال رامج الت  يقية  للوائلة تتي  لمستادم ا قدر متنوف من درجات تشبو  
ا طستادامدا   الفنية  ال در     علىك.ر  لديه  أله  كما  طختراعه   من   الكم يوتر  ت و ل    علىأج ح  

ال ور المس  ة طلى وور ميسمة  شكل متناسق والتعامل مع ا  كل اليوال  الت ميمية من 
 م( 2012-") ياسر س يلرتفاف  اللوا  التشكيل  ... طلخ دال ول  العرض  ا للخ
ع  وقص ال ور و وال  العيوف ا ا  شكل لكما  تي  للم مم س ولة طستادام أسلوف الت 

حتى ت نياته  ت ورات  وهادت  ملموس   والمنتديات    فن   ير  المواقو  ات ميم  ياتص  أوب  
مساعد  م مم طباعة المنسوجات فى اخرام ت ميماته ادقة حي  اا  م مم ل  ف و المتنوعة  و 

ل  ا ال رلامج من ا مكاليات ما يساعد الم مم فى التعامل مو الت ميم حي  استقبال ال ور  
لواا و مكن ملئ مساحات الت ميم  و تعد ل ا  أعن طر ق الماس  الضوئ  ومرولة فى ادخال  

 الشكل ال  يع  لل ماش ال ي تم ادخاله مسب ا اواس ة الماس  الضوئ  مما يس ل رؤ ة الشكل 
   (2000 -.) د نا"لواف ال ماش الن ائ والن ائ  للت ميم  
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تنفيذ   طباعيخطوات  ب   تصميم  الصور  من  مجموعة  دمج  خلال  برنامج  أمن  ستخدام 
 Photoshop الفوتوشوب 

للمستادمين دمج ميموعة من ال ور دلشاء لوحات فنية  Adobe Photoshop تي  ارلامج  
 متكاملة. وفيما  ل  الا وات المن يية لتنفي  ذلك: 

 د إعداد الملف الجدي -1
 .File > New رلامج   م طلشاء مشروف جد د من خلل اختيار ال  تم فت     -
  كسل( أو حس  ال اجة. )  تم ت د د أ عاد اللوحة الفنية وف دا لمت لبات الت ميم   -

 . dpi 300ادقة  RGB Color علىلضماا جود  عالية  يفضل عبي وعو ا لواا  -
 استيراد الصور وتجهيز الطبقات  -2

  حي   Place Embeddedأو    File > Open تم استيراد ال ور المراد دمي ا من خلل    -
 ترضاف كل وور  طلى المشروف ك ب ة منف لة. 

لضماا توه و العناور  شكل متناسق  مو عبي   Layers تم ترتي  ال ب ات ف  لوحة    -
 أولو ات ال ب ات وف دا للمف وم الفن  المراد ت قي ه. 

 دمج الصور ومعالجة الانتقالات البصرية  -3
ادمي ا   Layer Maskيستادم    - يسم   مما  ال ور   من  المر وبة  ا جحاء  ير  دخفاء 

   ر  ة سلسة دوا ادعرار  ال ور ا ولية. 
أدا     - استادام  اين   Gradient Maskأو    Eraser Tool (E) تم  تدر ي   الت ال  لالق 

 ال ور  مما يعحه من تداخل العناور الب ر ة  شكل متنا م. 
 يفضل استادام الفرشا  ذات ال واف الناعمة أ ناء المس  لت  يق تو يرات   ر ة ط يعية.  -

 ضبط الألوان والإضاءة والتباين -4

خلل    - من  اللولية  التعد لت  ت  يق  أدوات  Image > Adjustments تم  وذلك  استادام    
 م.ل: 
 Brightness/Contrast  .لت سين تبا ن ال ور  و عاءت ا 
 Color Balance وHue/Saturation  .لضبي درجات ا لواا 
 Curves وLevels  .للت كم ف  توه و ال لل وادعاء  لت  يق التواها الب ري الم لوف 
استادام    -  المباشر    Adjustment Layersيمكن  التو ير  دوا  ا لواا  ال ور    على لضبي 

 ا ولية  مما يس ل تعد ل ا  ح دا. 
 إضافة التأثيرات الفنية  -5
لت  يق تو يرات   ر ة  م.ل ت و ل ال ور  طلى لمي فن     Filter Gallery تم ا ستفاد  من    -

 مرسوم أو طعافة تو يرات تمو  ية لتعح ح العمق الب ري. 
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دعافة تو يرات  دو ة م.ل ادعاء  أو ال لل  مما يمن  اللوحة    Brush Tool (B)يستادم    -
ا فنيدا أك.ر تع يردا.   طا عد

خلل    - من  ألسية  أو  خامات  طدرام  الشفافية  استادام  Overlay Texturesيمكن  وعبي    
Blending Modes  .دعفاء طا و جمال  مميح 

 تصدير اللوحة بجودة عالية -6
الملف   ي ة    - حفظ  المست  ل     علىلل فاظ    PSD تم  التعد ل  ال ب ات    على طمكالية 

  File > Export > Save for Webلت د ر ال ور  الن ائية   تم اختيار    والعناور الماتلفة.
العمل   PNGأو    JPEG   م ت د د ال ي ة المناسبة م.ل  File > Save Asأو   وف دا  ستادام 
 الفن . 
 -:اعتبارات إضافية -7
 جود  ال ور عند تعد ل حيم ا أو ت ر ك ا.  علىلل فاظ  Smart Objectsاستادام  -
ا ستعالة اه    الماتلفة لرؤ ة تو يرات دمج متنوعة اين ال ب ات  Blending Modesتوظيف  -

Clipping Masks  ال ب ات ا خرى.  علىطب ة معينة دوا التو ير  على لت  يق التو يرات 
 الاصطناعيالذكاء  -
ال كاء    أوم   ا و ناع يم.ل  ومن  الرا عة  ال ناعية  ال.ور   وم ركات  مارجات  أوم  أحد 

و أحد سمات الع ر ال د    الم  ل ات الت   تم تداول ا  شكل أعتيادي ف  الوقع الراون   
و ناعى   فه عامة وو  الت دم العلمى والتكنولوجى لتعدد استاداماته   فال كاء ا  علىال ائم  

 م( 2019-)أاو  كر".أو ال اسوف ا لةفى   ا لسااال كاء ال ى ي  نعه 
( وو ميال ف  علوم الكم يوتر   تم ات و ر ا ل مة وال رامج الت  AI)  ا و ناع ال كاء   

البشري   علىتتمتو  ال در    ال كاء  ال كاء     م اكا   م  ل   كلمتين    ا و ناع و تكوا  من 
  علىتعن  ال در     Intelligenceتشير طل  شئ م نو أو  ير ط يع   ال.الية    Artificialا ول  

التعلم والتعامل مو   على يعن  ال در  المعرفية    ا و ناع التفكير أو الف م من  م فإا ال كاء  
ساا كوساس لت و ر ال رمييات و   ل ت  أي أله يوخ  من الع ل البشري وكيفية تعلم االمشكل

 م( 2023-)أسماء ".ا ل مة ال كية
"الشاء ارامج كم يوتر تنارن ف  الم ام  بأنهMarvin Lee Minsky مارفين لي مينسكي وعرفة 

ال اكر     تن يم  م.ل  عالية  ع لية  عملية  تت ل   ف    مرض   البشر  وليحوا  شكل  ي وم  الت  
 ( southgat-2019)والتعلم اددراك   والتفكير  ل دي".
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 الفن التشكيلي   في الاصطناعيالذكاء دور  •
ال كاء   الفنالوا  أعمال م    AIا و ناع استادم  طل   أفكار جد د   التار خ  دعافة  ع ر 

طذ ليد  “م.ل لوحات الفن الواقع  وفن ال  يعة ال امتة  الت  ظ رت ف  ال را السادس عشر   
 Johannesووالة فيرمير  أا  اح.اد ار  الياد تووَل طل  ل ر ة م م ة  ت. ع أا الفناا ال ولندي  

Vermeer    و يرت من معاور ه  استادموا الكاميرا الم لمة الت  كالع أدا  ت نية   ر ة ف  ذلك
لوحات    الع ر  من  عدد  الا راء  إدخال  من  فر ق  الكم يوتر     طل   Rembrantرامبرانتوقام 

سنة     350وألتيوا لوحة جد د   وسلوف الفناا ال ولندي  وكوا رام رالع ال ي توف  ق ل ل و  
 (Jonas-2022)".رسم ا انفسه

فاكتشف ا لمان الت  كاا  رسم   ه  د قام ج اه الكم يوتر  يمو ال يالات  ودرس أسلوبف 
د   م.ل ملم  الوجه والعينين  وطر  ته ف  رسم المناطق المضاء     ا ا  عض ال فات الم د 
طلتام وور    كيفية  الآلة  تعلم  ألشو خوارهميات  التفاويل   م  من  و يروا  ال ل   ف   الت   وتلك 

 ( 1وور ).  جد د  

 
 

 

 ال كاء ا و ناع   وسلوف رام رالع الفر دطا أول عمل جووري ف  ميال  لوحة  ( 1)  صورة 

MODJENY:-  ال كاء    اد واحد   ديع أدوات  أك.ر  ال ور    ا و ناع من  وتعد ل  ش ر   لشاء 
 Text  ةي  و  لق عل ابضو كلمات ف ين ت و ل خيال ا لساا طل  عمل فن   والرسم  حي  يمك

to image Generation  "  لت و ل أل مة  ال ائمة  النوو   ال ور  طل   الت ول    علىص  لماذم 
وس ولة  المت ور   لل درات  ول را  الفنية  وا عمال  الرقمية  ال ور  شائعة  لشاء  وس لة  العمي ة 

   وو ا الفن من الفنوا الرقمية المركبة من لماذم ا لشاء العمي ة  أل مة ت ول النص طل  وور 
ا خر   تلو  ال فر  كسل  من  الت ميم  الربوت  الشاء  ي وم  وت توي    pixel by pixelحي  

الناتيه   أا    على الت ميمات  طل   يشير  مما  الم دد  النص  ف   موجود   طعافية  ير  تفاويل 
  الفناا   هول د أستادم  م(2004-)مرح.خيال أو ناع "  علىي توي اداخله    ا و ناع ال كاء  

 سرح أوبرا الفضاء"  م ل ناعة لوحته "  Jason ALLENجسيون ألن 

https://www.oracle.com/ae-ar/artificial-intelligence/what-is-ai/?source=rh-rail
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 (2)  صورة 

Midjourney. (Screen grab, used in accordance with Clause 27a of the Copyright Law) 

 الطباعة الرقمي -4
ا فهه  ميههال Inkjetال باعههة الرقميههة علههى ا قمشههة ات نيههة النفهه  ال  ههري )تعههد  ( ت ههوردا م مههد

   ال باعة الت  ت وم اترجمة الن ام الرقم  ول له الهه  ل ههام ال بههو والهه ي فالمنسوجات      باعةت
ي هههوم اهههدورت فههه  ل هههل ال هههور  الههه  الاامهههات التههه  سهههيتم ال باعهههة علي ههها وكلمهههة رقميهههة تعنههه  ل هههل 
ال يالات الرقمية الم فوظة علي ا ال ههور  فهه  ال اسههوف الهه  ال ا عههة والتهه  اههدوروا ت ههوم  اسههتقبال 

 .تلك ال يالات وترجمت ا ال  ال ور  الم لوف طباعت ا
ت هههههدأ مهههههن اختيهههههار الا هههههوات  ول ههههها وههههه  سلسهههههلة مهههههن "تعهههههرف ال باعهههههة الرقميهههههة طجرائيهههههاد و  

 اسههههتادام "ال مههههاش  علههههىالت ههههميمات وتنفيهههه وا  الت نيههههات ال د .ههههة   ههههم طباعههههة ال ههههور  رقميهههها 
 ت المن ومهههة وههه الف هههائل المناسهههبة مهههن ال هههب ات ل باعهههة جميهههو ألهههواف خامهههات النسهههيج  وتعمهههل 

 ت الت نيههة ال د .ههة وهه ا دورت  منتيهه  الدقههة والكفههاء  وعرفههع   شكل متيالة حي   ؤدي كل جحء من
 ت الت نية يمكههن تعههد ل و  وف  "Technology Printing Digital"  اسم تكنولوجيا ال باعة الرقمية
ميهههال الههه ي يعمهههل اهههو واسهههتادام المهههؤث ارت المت هههور  ل رلهههامج لميهههام ال اسهههوف الرقمههه  و ف هههاد ل

لت  يق لتائج عالية اليود  كما أل ا تتههي  المرولههه  ال د .ة  Adobe Photoshop أدوب  فوتوشوف
 م(2019-)وسام ."الت ميمات ال باعية  علىف  التعد ل  

 أنواع الأحبار المستخدمة في الطباعة الرقمية على الأقمشة: •
(: يرسههتادم  شههكل أساسهه  مههو أقمشههة ال وليسههتر.  تميههح   درتههه Disperse Inkح ههر التشههتع ) -

علهههى التسهههام  عنهههد التعهههرض لهههدرجات حهههرار  عاليهههة  ممههها يسهههم  ل لهههواا  ا لهههدمام  عمهههق فههه  
ا ألوالدا هااية و باتدا عاليدا.  ا لياف  منتيد
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مناسهه  ل ليههاف ال  يعيههة م.ههل ال  ههن  ال ر ههر  وال ههوف.  (:Reactive Inkالحبر التفاعلي ) - 

ا مههو ا ليههاف  ممهها  ههؤدي طلههى  بههات ألههواا ممتههاه وملمههة لههاعم علههى   تفاعههل وهه ا ال  ههر كيميائيههد
 ال ماش.

يرسههتادم مههو ا قمشههة الم ههنوعة مههن ال وليسههتر.  تباههر  (:Sublimation Inkحب  ر التس  امي ) -
ا ت اميم دائمة وحيو ة.  ال  ر عند التساين  مما يسم  له  ا لدمام ف  ا لياف  منتيد

مناسهه  ل ليههاف ال روتينيههة م.ههل ال ر ههر وال ههوف.  ههوفر وهه ا  (:Acid Inkالحب  ر الحم   ي ) -
 ال  ر ألوالدا هااية و باتدا عاليدا  و رستادم  شكل شائو ف  ال باعة على ا قمشة الفاخر .

 أهمية الطباعة الرقمية في التعليم •
استكشهههاف طمكاليهههات جد هههد  للتع يهههر الفنههه  مهههن خهههلل  علهههىتشهههيو ال باعهههة الرقميهههة ال هههلف  - 

 التكنولوجيا.
 تنم  م ارات الت ميم والتفكير اداداع  لدى ال لف من خلل التفاعل مو ال رامج ال د .ة. - 
 تعحه من طدمام التكنولوجيا ف  المناوج الدراسية  مما  ربي اين الن ر ة والت  يق. - 

  : ةمميزات الطباعة الرقمي •
اسههتادام أج ههح  طباعههة رقميههة مت ههور   علههىالمنسههوجات  علىتعتمد تكنولوجيا ال باعة الرقمية 

وهه ت الت نيههات تسههم    وال باعههة الليحر ههة (Inkjet) تعمههل ات نيههات ماتلفههة كال باعههة الناف.ههة لل  ههر
ل ههها طر  هههة ا ماتلهههف ألهههواف ا قمشهههة والمنسهههوجات علهههى إلتهههام ت هههاميم وطباعهههات عاليهههة اليهههود  

 ومن مميحات ا:   ل تكنولوجية تواك  الع ر  استادام ال اس  ا 
  . ل ائية ف  ال ا عةطباعة لولية متميح  ل را لتعدد الدرجات اللولية ا -
 .طباعة جميو التفاويل الدقي ة الت  ت ل ال  جحء من المليمتر اوعوح ودقة-
 ق ل طباعته  ل امكالية رؤ ة الت ميم عن طر ق ال اس  ا  -
 تفو  ال باعة اليدو ة ف  توفير الوقع والي د -
 ال باعية  س  ا تات ر عمليات التي يح الماتلفة  -

 
 ماكينة طباعة رقمية مباشر  على ال ماش   ( 3)  صورة 



 

 875 

 المجلة العلمية لكلية التربية النوعية

 

 الجزء الاول  2025العدد الثلاثون ابريل  
 Abstractionism المدرسة التجريدية-5 

م اكهها   علههىت ههو ر فكههر الفنههاا أو شههعور  ت ههو را   يعتمههد  علههى"اتيههات ي ههوم   يعت ر التير ههد
والتركيههح عههن الواقههو   ههالتال   تميههحو   7 لموعوف معين مو استادام ا لواا أو ا شههكال ال ندسههية"

تيههرؤاد وت ههدياد ل سههالي  الت ليديههة  ا شههكال ال ندسههية وا لههواا والا ههون  ووههو أسههلوف أك.ههر علههى
" رمههه  التير هههد فههه  تنهههاول الرمح هههة طلهههه  رد ا شهههياء طلههه  أوهههول ا اليوور هههة  و سهههتنتج و فههه  الفهههن

التير هههههههد التهههههههوليف اهههههههين ال ههههههههور التهههههههه  تهههههههههوح  ا ههههههههها الرؤ هههههههههة الفنيهههههههههة  وبهههههههههين وهههههههههور العهههههههههالم 
 (1992 -م سن ع يه(".الاههارج 
"اهههدأ فهههن الت هههو ر اللشهههكل  أو التير هههدي كوسهههلوف مهههن أحهههدي مهههدارس الفهههن ال هههد    وووههه 

أسههالي  مهها  عههد ال ههرف العالميههة ا ولهه  وفهه  ططههار حركههه الت ههرر أوههب  الفنههاا فهه  حاجههة طلهه  
الاههروم مههن ال واعههد الت ليديههة ال ديمههه للووههول طلهه  طههر  جد ههدت وبنيههة  طاداعيههة تسههم  لههه ات ههديم 

 . ت ا   ر  م تكر  اأعمال   ر  ة تيسر له عرع ا  لمان مست د ة   ي
فمههاذا تكههوا التيربههة اليماليههة  "و  ههول وربههرت ر ههد" أا الفنههوا جميعهها ميههرد   شههكل م تهه  وا 

الت  لحف عن ا   اؤوا العرض وارتباط ا سوي طستيا ة مههن ا لسههاا وع لههة للتنا مههات المنعحلههة  
أا الفن وروف من الفوع  طله حركة م سوبة م كومة  ا رقام ألههه كتلههة ي كم هها مقيههاس معههين 

 (1968-وربرت(."وو  حركة الشكل وتن يمه ال ة ا رقام وال سا ات  عد تير دت 
"فاللوحههة التير ديههة عبههار  عههن ميموعههة مههن الا ههون وا شههكال التهه    مههدلول ل هها و  تههرتبي 
 وي أشكال مولوفة فهه  الواقههو أي أل هها ق عههة ت ههو ر ة ف سهه   ومهها دامههع   تع ههر عههن موعههوف 
مهههههها  فول هههههها ت ههههههب  وهههههه  ذات هههههها موعههههههوعا  قيمتههههههه فهههههه  انههههههات الههههههداخل  وفهههههه  تن ههههههيم عناوههههههرت 

 (1996-)م مود أم ح".وأجحائه
 مذاهب المدرسة التجريدية   •

رتبي م هه ل  التير ديههة العضههو ة طرتباطههاد و ي ههاد  ال  يعههة  مهها  ن ههوي  هه  -:التجريدي ة الع   وية -
علي ا من م اور ماتلفة  وقيم جماليههة وفنيههة  فال  يعههة مههورد الفنههاا الهه ي    نضهه  ووهه  تم.ههل 
م ههدراد وامههاد مههن م ههادر طل ههام الفنههاا  ومنبههو الرؤ ههة اليماليههة والتشههكيلية  واليمههال فهه  ال  يعههة 

 علههىلاتج عن تناسج ال واور و لسههيام ا ودراسههة وهه ت ال ههواور والتعمههق في هها  نههتج عن هها التعههرف 
ممههها كهههاا لهههه ع هههيم ا  هههر فههه  أعمهههال ك.يهههر مهههن  القهههيم اليماليهههة والهههن م ال نائيهههة الميهههرد  في ههها

 .و   ر التير د العضوي ف  أعمال كل من ونري مور   اربارا ويي ورث  وجاا أرف"الفنالين
خلق تيربة حسية وب ر ة جد د  ف  العمههل الفنهه  مههن  علىوو ال در  "  -:ةالتجريدية الهندسي  -

خلل استادام شكل أو عد  أشكال وندسية ف  العمل الفن   حي  لشوت وهه ت ال ركههة الفنيههة فهه  
مههن ق ههل  عههض الفنههالين الهه  ن فتنههوا  ا شههكال ال ندسههية وذلههك  عههد  فهه  أوربههاادايههة ال ههرا العشههر ن 

 ن أوههم مؤ ههدي وهه ا الفههن ومهه  ات ب  هها داخههل اعمههال م الفنيههة  ادايههة فتههر  ال نائيههة فهه  روسههيا وقههاموا
 (4)وور  .خلفية عملة  ال ندسة المعمار ة  علىماوول  لاج    مارتن اروكتر مستندا  
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 (4)  صورة 

 م1957سم، 111× 195توال،  علىزيت  "،  Clyfford Still    "،D-No. 1 كلفورد ستيل

Collection Buffalo AKG Art Museum 
الهندسية في روسيا    - التجريدية  لم  نتشر التير د ال ندس     -:م1935-1915الحركة 

الاالص اين الفنالين الروس ا   عد أا أكتشف أحد الرواد الروس الميدد ن) الشكل المربو(   
 ( 5وور ).. ووو الم ور ماليفيتش ال ي تحعم شعبة )سوبر يماتيحم( أي التفوقية

 

 (5) صورة 

 م1912سم  111×195توال   علىه ع   " ال  اف"   Casimir Malevitch كازيمير مالڤيتش
Collection Buffalo AKG Art Museum15 

"ظ رت ا دف الب   عن أسلوف  -:م1932-1917الحركة التجريدية الهندسية في هولندا  -
جد د ف  الفن التير دي ف  الفتر  الت  ظ ر في ا الفن التركي   ال نائ  ف  روسا  حي  أكتشفع  
جماعة من الفنالين ف  وولندا أا اليمال الم.ال  يكمن ف  الشكل ال ندس  وعمع ميموعة 

كل  اول  و  مولدر اا  ايع  وأش روم  ومعمار ين  الم ور ن  اسماعيل". من     (19983-)لعمع 
 ( 6وور )

https://buffaloakg.org/person/clyfford-still
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 (6صورة) 

 م1927سم  101×74ور    على جواش وح ر  "  ة " السفن الشراعي Paul Klee بول كلي

الرمزية  - ال ي"  -:" التجريدية  التير د  النوف من  ال  يعة  ي  الرمح ة و  ذلك  معاليه من  ستمد 
ذات ا لكن ا ت ور ا ا ف  م او ت مستمر  او م او ت من ال  ف والتوكيد أي ح ف العناور  
ال ير رئيسية وتوكيد الكياا الرئيس  تدر يياد ال  أا ت ل ال  خلوة الشكل مم.لد ف  ) رمح 

  يعود ف  الفن ال د      الرمحي   وا مدخل التير د فوب لك       ت ر باد  وح   ال  يعة و  ي ا   ا  (
ال  يعية يعت ر    ا وول  ال ي  ال فل  وفن  والشع ية  ال دائية  السا  ة  الفنوا  ف   ج ورت 

 ( 1980 -)م مود البسيول ".تير داد 

الحركية  - الفكر  في ا لية تير د ا شكال الساكنة ف س   ولكن ف  أ ار ا شكال   : التجريدية 
المت ركة والدائمة الت رك  وما ت د ة من أشكال جال ية  فعل ال لل وت رك ا وقادوا الكسندر  

تكوا لا عه من أ ار ا شكال المت ركه و    معل اته التير دية المتالفة  Calder Alexanderكالدر
والدائمة الت رك وما ت د ه من أشكال جال ية ان ل ال لل وت رك ا و ا  ادعافة طلى ا شكال 

و  الشير    عل الساكنه   ظلل  ورا   ف   يشاود  التير د  من  النوف  و ا  أا  الم.ال    علىس يل 
ت دوا   طي اعات  متكرر   كمساحات  تكوا  حينما  ال  يع   ا ورا   م حاوا  ت  ر  و   ا رض 

 . فرا ات عوئيه فات ه 
النقائيةا  - اين  "  لتجريدية  ظ رت  فنية  النحعة    1925-1918حركه  من  مستوحا   وو  

التكعي ية    رض الووول طلى ال والين الت  ت كم ا شياء  وأرادت أا ت ل ا ا الى ما يسم   
ال نائية   ال والين  التشكيلية  أى  الناحية  الت  ت كم ا شياء من  ال والين  الى  الاالص أي  الن اء 
الحجاجات   ادتيات  و ا  فنالوا  استادم  وقد  أك ر  اليمال   عمق  المعنى  تشو  أا  يمكن  الت  

https://www.meisterdrucke.ae/artist/Paul-Klee.html
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توكيد   طلى  ال  ال  يعة  ت ليد  طلى  في ا  يسعوا  ل لول    كم در  ال امتة  ال  يعة  وعناور 
 -: ومن أش ر الفنالين العلقات التشكيليه وأسة الت ميم  وتحعم و ت النحعة طميديووهولفات

التعبير   - فن   -:يةالتجريدي  "اتيات  ف    أوربا  ف   التع يري  التير دي  الم و   ظ رت طلئو 
حد   وفيه تتواول حالة الفناا العاطفية مو مشاودي ا عمال  عن طر ق وور تع ير ة مليته  

 .  علمات تير دية أو ميرد  من ا شكال الواقعية  م.ل عربات فرشا  قو ة  وخ ون وألواا

 
 (7)  صورة 

 1925سم  68×43توال    علىه ع   " أوفر وأحمر وأهر "   Wassily Kandinsky اسيلي كاندينسكيو 
 ثانيا: الأطار التطبيقي: 

 فلسفة التجربة: 
 استادام ال كاء     ا سلوف التير دي طباعية  خ وات تنفي  تيربة عملية لعمل لوحات

 . Inkjet ا و ناع  وبرامج اليرافيك وطباعت ا  ال باعة الرقمية
 أهداف التجربة:   -1
 تيمو اين ت نيات ال كاء ا و ناع  وبرامج اليرافيك. م تكر    طباعيةلوحات   تنفي  • 
 ال د .ة.  ت و ر ال يا ات التشكيلية الت  تعكة ا فكار اداداعية والمفاايم الفنية • 
 طعداد أعمال فنية جاوح  لل باعة الرقمية مو ت  يق التواها اين الت نية واليماليات.  • 

 ضوابط التجريب: 
التير      -1 ال.الوي    علىتم  ا ول  ال ف  والتكنولوجيا  –طلف  للعلوم  المتفوقين    -مدرسة 

  كفر الشيخ. 
 .2025-2024للعام الدراس  طال  وطالبة   ( 16عدد ال لف ) -2
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  تم التير   اواقو ح ه أس وعيا لمد  ف ل دراس  )ا ول(  -3
أع   الفروه لل لف المتفوقين ستيم ف  الور  أفكاروم ف  تنفي  لوحات طباعية تتسم    ول د

الرقم    المراد    علىالتوكيد  ال كاء ا و ناع  وبرامج اليرافيك   التير د من خلل الفن  الفكرت 
للتوكيد   الرقمية  ال باعة  التشكيلي  علىتنفي وا  وستادام  ال باعية     ةاليمالي  ةال يو  للوحه 

   ف و تض  ذلك 
 خطوات التجربة: -

 اختيار الأدوات والبرامج المناسبة: 
ألمان    على تدر   ا دوات     لتوليد ت اميم فنية    MidJourney : برامج الذكاء الاصطناعي  -1

 (  استادام مدخلت فنية م دد   اتكار لوحات ذات طا و خام. Stylesمعينة )
الجرافيك   -2 ارلامج:  برامج  فنية  Adobe Photoshop  استادام  ألمان  يمكن م     دلشاء 

وم تكر   فر د   ت اميم  دلشاء  المت دمة  الت نيات  تعد لت     استكشاف  ا لواا     على طجراء 
 والا ون لح اد  جود  الت ميم الن ائ . 

الت نيات الرقمية لت و ل أعمال م الفنية طل  لماذم  ال لف ستادام  ي  أدوات الطباعة الرقمية:  -3
تي يح  . ال ماش  علىتدعم ال باعة    والت اختيار طا عة رقمية  و   المنسوجات  علىجاوح  لل باعة  

 اللوحات لل باعة الرقمية: 
 (. CMYKعبي اللوحات ف  ارامج الت ميم وف دا لمت لبات ال باعة )م.ل طعدادات ا لواا  -
 ت د د ا  عاد الن ائية للوحات  ما  ناس  حيم ال باعة الم لوف.  -
 ( لتس يل عملية ال باعة. Crop Marksطعافة علمات ادرشاد ال باع  ) -

 عبي طعدادات ال ا عة الرقمية )م.ل الدقة واليود (.  • 
 طجراء اختبار طباعة و ير للتوكد من ت ااق الت ميم مو النتائج الفعلية.  • 
 طباعة اللوحات الن ائية ادقة عالية لضماا طاراه التفاويل وا لواا.  • 
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 من اللوحات الطباعية نتائج التجربه 

 
 ( 8)  صورة

 حبيبة محمود عبده أسم الطالب:  
 سم 45×45مساحه العمل 

 
 ( 9)صورة  
 رنا حسن أسم الطالب: 

 سم 45×45مساحه العمل 

 
 ( 10)  صورة
 على هنا أحمد أسم الطالب: 

 سم 45×45مساحه العمل 

 
   ( 11)  صورة
 السيد  أحمد حبيبة أسم الطالب:  

 سم 45×45مساحه العمل 

 
 (12)  صورة 

 أيه ياسر سطوحي أسم الطالب: 
 سم 45×45مساحه العمل 

 
 (13)  صورة 

 حنين عبد الرازق منصور أسم الطالب:  
 سم 45×45مساحه العمل 
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 ( 14)  صورة

 جودي أحمد الحايس أسم الطالب:  
 سم 45×45مساحه العمل 

 
 ( 15)صورة  

 أمنية إبراهيم صالح أسم الطالب: 
 سم 45×45مساحه العمل 

 
 ( 16)  صورة

 أشرقت عبد الفتاح بلال أسم الطالب: 
 سم 45×45مساحه العمل 

 
 ( 17)  صورة

 روفان السيد محمدأسم الطالب: 
 سم 45×45مساحه العمل 

 
  )18)صورة  

 منه علاء مدحت أسم الطالب: 
 سم 45×45مساحه العمل 

 
 ( 19)صورة  

 جلوريا مشيل مرجان أسم الطالب:  
 سم 45×45مساحه العمل 
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  )20)صورة  

مساحه    أمنية مظهر تاج الدينأسم الطالب: 
 سم 02:×02العمل

 
  )21)صورة  

 بسنت هشام الشربينيأسم الطالب: 
 سم 02:×02مساحه العمل 

 
  )22)صورة  

مساحه    إيهاب فوزىوهاندا ر أسم الطالب: 
 سم 02:×02العمل

 
  )23)صورة  

 جودي محمود محمد أسم الطالب:  
 سم 02:×02مساحه العمل 

 : التحليل الفني للتطبيقات العمليه للبحث
   المواد العلميةا عمال الفنية الناتية عن الت  ي ات العملية ت مل تو يرات فنية مستوحا  من  

ااتكار معل ات طباعية    على قدر  ارامج اليرافيك وال كاء ا و ناع     ال باعية تعكة ا عمال  
تعتمد   حي   العلوم   من  المن م     علىمستوحا   و ير  المن م  التما ل  اين  تيمو  تكو نات 

أجحاء   اين  الترا ي  ت  يق  ف   يس م  مما  والدائر ة   ا فقية   الرأسية   المسارات  طلى   ادعافة 
العمل الفن  ع ر تنوف حركة الا ون وأشكال ا. ي  ر ذلك اوعوح ف  اللوحات ال باعية شكل 

( مما   ره مدى توظيف التكنولوجيا لتنمية اليال  اداداع  والتير     14  22  18  12)رقم 
 . STEMلدى طلف 

ا عمال  و  ي  ر   علىتؤكد  حي   والتشكيلية   الفنية  الرؤ ة  لتوسيو  كمدخل  التير    أومية 
ل عمال  التع ير ة  ال و   طاراه  ف   والبارد   الساخنة  ا لواا  تساوم  طذ  اوعوح   اللول   التيالة 
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ف    ي  ر  كما  عناور     ( 23   21   15   8)رقم    وور  ال باعية   اين  اللول   التوافق  و ا 
التكو ن يعحه من ا تحاا الب ري داخل العمل الفن   لية ف ي من خلل توه و الكتل  ولكن  
ال باعية   اللوحات  ف   ما  تيلى  ووو  والمساحة   الملمة   الاي   اللوا   توظيف  ع ر  ا  أيضد

 (. 17  19  10)  وور  شكل  الرقمية 
تت  ق الوحد  الب ر ة ف  ا عمال من خلل طدراك العلقات اين العناور التشكيلية  مما 
مف وم   تؤكد  متنوعة  أشكال  من خلل  الروا ي  و ت  وت ره  ال باع .  العمل  تماسك  طلى   ؤدي 

(. طعافةد طلى ذلك  تتيسد القيم التشكيلية م.ل  13   20)رقم    وور الوحد   كما وو واع  ف   
ال باعية اللوحات  ف   الفراغ  وعلقات  ال ائر   الباره   التياور   التشا ك   التداخل     الترا ي  

مما يعحه من قيمة التير   وا اتكار ف  طلتام أعمال  ير    (. 11 16   9)رقم    وور   الرقمية  
 ت ليدية. 

ف  ا عمال والمساحات  الا ون  تكامل  الرقمية   تيلى  تواهلدا   ر دا  ال باعية  مما ي  ق    
اداداع   التفكير  تعحه  الت   الم مة  اليمالية  المباد   أحد  الشعور  ا تحاا  ووو  متناس دا  .ير 

طلف   الت ن   STEMلدى  اليال   اين  الفعل   الدمج  الت  ي ات   ت  ق  و ت  خلل  ومن   .
طباعية   مشار و  ت و ر  من  ال لف  حي   تمكن  علمية    علىقائمة  رقمية  واداداع    أسة 

التيربة خ و  ل و   ا لك  تشكل و ت  التشكيلية.  ط راء خ رات م وم ارات م  وفنية  مما يس م ف  
قاد    لي ب وا  ال لف  تمكين  رؤ ة  مما  دعم  التعليم   ف   اداداع   والتفكير  ا اتكار  تعح ح 

 المست  ل ف  الميا ت العلمية والفنية. 
 النتائج والتوصيات: 

 أولا: النتائج: 

ل ناء    - تير     كمن لق  ا و ناع   وال كاء  اليرافيك  ارامج  امكاليات  من  ا ستفادت  يمكن 
طباعية   وال كاء  و    :مست د ة تير دية  معل ات  اليرافيك  ارامج  أا  الب    لتائج  أظ رت 

تير دية م تكر . تمكن رقمية  ا و ناع  تعد أدوات فعالة ف  ت ميم وتنفي  معل ات طباعية  
ال لف من توظيف طمكاليات و ت ال رامج دلتام ت اميم تتميح  ال ا و اداداع  والتير دي   

 ما أدى طلى الاروم من ططار ال باعة الت ليدية ل و ت ورات أك.ر حدا ة وتير بدا. 
  من خلل استادام ارامج اليرافيك:   STEMتنمية اليال  ا اتكاري والم اري لدى طلف    -

أ  تع الدراسة أا استادام ارامج اليرافيك ساوم  شكل مباشر ف  تنمية اداداف والم ارات الفنية  
. وفرت و ت ال رامج ايتة تعليمية م فح  للتير    ما عحه STEMلدى طلف مدارس المتفوقين  
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ت و ر    على قدرت م   طلى  وأدى  طاداع    الت نية  وسلوف  الت ديات  مو  والتعامل  الفن   التع ير 
 . م ارات م ف  الت ميم وال باعة

 ثانيا: التوصيات: 

 ووى اتضمين ارامج اليرافيك وال كاء ا و ناع  كيحء أساس  من المناوج الدراسية ف    -
 .   لت و ر الم ارات اداداعية والت نيةSTEMمدارس المتفوقين 

أمام    - يفت   مما  التكنولوجيا   خلل  من  الفن   التير    تدعم  تعليمية  أسالي   ات ن    ن   
 ال لف  فاقدا جد د  للتع ير الفن  و لتام أعمال  ير ت ليدية. 

تنمية    على  ن    العمل    - ف   يرس م  مما  والفنوا   العلوم  اين  تدمج  تعليمية  مشار و  ت و ر 
 التفكير اداداع  لدى ال لف و  راء ت ورات م الفنية من خلل المفاايم العلمية. 

اليرافيك    - طلكترولية أو مادية لعرض أعمال ال لف  استادام ارامج   ووى  إقامة معارض 
 المح د من ا اتكار.  علىوال باعة الرقمية  مما يعحه   ت م  ولفس م و شيع م 

من   - ل ا  لما  وفنية   تعليمية  كوسيلة  المدارس  ف   الرقمية  ال باعة  استادام  اتوسيو   ن   
 طمكاليات ف  ت و ر جود  الت اميم و  راء العملية التعليمية. 

ت و ر اداداف    على ووى  إجراء مح د من الدراسات حول تو ير التكنولوجيا وبرامج الت ميم    -
 . توظيف ال كاء ا و ناع  ف  ميا ت جد د   علىالفن  لدى ال لف  مو التركيح 
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 -المراجع:
 العربية والمترجمة  كتب ال -أولا
خالد -1 بكر  لتعح ح تنافسية من مات   :(2019)  -أبو  ال كاء ا و ناع  كتوجه حد    ت  ي ات 

  1المركح الديم راط  العرب  للدراسات ادستراتييية والسياسية وا قت ادية  اليحائر  ن  نا عمال
 . 39م

أمهز -2 المعاور   :(1996)  -محمود  الفنية  للتوه و والنشر  ايروت      التيارات  الم  وعات  شركة 
 . 31ل ناا  ال بعة ا ولى  م 

البسيوني  -3 الفن  :(1980)  -محمود  ف   ن   التير د  ال اور    الم ر ة   الن ضة    1مكتبة 
 . 149م

 . 217ال يتة العامة الم ر ة للكتاف  م  الفن ف  ال را العشر ن :(2002) -محمود بسيوني -4
  ال اور   1دار المعارف  ن   فنوا ال رف ف  الفنوا ال د .ة  :(1983)  -نعمت إسماعيل علام  -5

 . 179م
 . 85سام  خشبة  دار الفكر العرب   ال اور   م :ترجمة  معنى الفن :(1968) -هربرت ريد  -6
الوسيط -7   ال بعة الرا عة  “خام اوهار  التربية والتعليم”  ميمو الل ة العربية  :(2004)  -المعجم 

 . 115م ر  ال اور   م
سهيل -8 استادام   :(2009)  -ياسر  أومية  والعمار :  الت  يقية  الفنوا  ميا ت  ف   الت ميم 

 . 36دار الكتاف ال د    ال اور   م  الكم يوتر ف  الت ميم
سهيل -9 استادام   :(2012)  -ياسر  على  ت  ي ات  الكم يوتر:  الت ميم  استادام  وفن  ا اتكار 

 . 25دار الكتاف ال د    ال اور   م  الكم يوتر ف  الفنوا 
 ثانيا الرسائل علمية 

النور  -10 أاو  عفيف   م مد  ويا ات   :(2000)  -ع ير  لعمل  ال ندسية  للتير دية  اليمالية  القيم 
 . 38 ير منشور   كلية التربية الفنية  جامعة حلواا  م  رسالة ماجستير  معدلية جد د 

الدياسطي  -11 الحمادي  العلوم    :(2018)  -عزة  ف   المتفوقين  لتفعيل مدارس  استراتيييات م ترحة 
مدخل   مت لبات  ف  عوء  دكتوراه   STEM Educationوالتكنولوجيا  م ر  منشور      رسالة   ير 

 . 206م
نفادي   -12 أحمد  المعل ات   :(2000)  -دينا  طباعة  ت ميم  تشكيلية  اتكار  كقيمة  التكعي ية 

 . 45 ير منشور   كلية الفنوا الت  يقية  جامعة حلواا  م  رسالة ماجستير  المعاور 
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 مجلات علمية ثالثا: ال
ال كاء ا و ناع  وا تياوات المعاور  ف  الفنوا التشكيلية.   :(2023)  -أسماء ماهر عيد    -13
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المطلب  -14 عبد  إبراهيم  عابد  أمجد  توفيق،  محمد  الدين  مدارس "  :(2019)  -صالح  مست  ل 

ميلة    " ( من من ور من يية ستة سييما وأسلوف السينار وSTEMالمتفوقين ف  العلوم والتكنولوجيا )
 . 17  طار ل  م1  اليحء 118  جامعة ان ا  العدد  أ  اث كلية التربية

عطية  -15 محمد      منشور     ا والة والمعاور  ف  الرمح ة والفن الرمحي   :(1992)   -محسن 
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